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Effective May 2025, this guidance has been updated.
To foster consistency, this is currently the recommended method of importing data into OpenX products.

» Issue: Points imported via GPK file come in as “Point Entity 3D” vs importing from ASCII which shows points as
a Point element (Bug 928038)
o As of May 2025, this issue persists in all versions of software from Bentley
o When the issue is resolved, this document will be updated and provided to KDOT ROW Engineering and
posted with the next KDOT workspace release.
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IMPORTING COGO/XML DATA
FROM FILE INTO OPENX

Guidance for Bureau of Right of Way
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IMPORTING COGO/XML DATA FROM FILE INTO OPENX | Overview |

Overview

It should be noted that the processes outlined below are assuming there is existing data that needs to be
moved from legacy v8i to OpenX Connect. KDOT does not mandate the use of GeoPak or other COGO
products, only providing guidance on transferring COGO data, where COGO was used for Point placement.
Questions related to ROW processes and workflows should be directed to KDOT Right of Way Engineering.
Questions related to KDOT Workspace resources, Software Use Policy, etc. should be referred to
kdot.cadd.support@ks.gov

Preparing COGO File for Import to OpenX Product

Exporting Points to an ASCIl/Text File

Video Demo

In PowerGEOPAK — Open COGO
GEOPAK->Road—->Geometry->Coordinate Geometry

- Power GEQOPAK V&i (SELECTseries 10)

tilities  Workspace | GEOPAK indow Subsurface Ltility CADconform Help @ﬂ ~* [ w_Plat_z_n -
— - L
ROAD ¥ ROAD Toals
3

SURVEY
Hé O & DRANAGE v
LANDSCAPE y|  Active Chain Control

WATER SEWER y| Element Attrbutes
3PC AdHoc Attribute Manager

Project Manager

Training

Activate Map

Coondinate Geometry
LUezign & Comp (Graphical Coordinate Geometry
Quantity Manager Layout Alignments Horizontal
Plans Preparation ¥|  Design Multicenter Curve

Login using the Job number for the and Operator code “RW”

Enter job number and

operator code (These

can be inferred from
the naming of the
input/output files)

Coordinate Geometry

dob: (84319, [] A_SEC843.0RW
Operator Code: | rw o
SV [ b_aligd3.irw
[ B_ALI243.0RW
Cancel
[ b2_atig43.irw
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IMPORTING COGO/XML DATA FROM FILE INTO OPENX | Preparing COGO File for Import to OpenX Product |

1. Within the COGO dialog, Select File>Export—ASCII Points

i Coordinate Geometry  Job: 843 Operator: rw
FEile §Edit Element View Tools
Eerences 4

Input File Ltility
Input File Bestore

Database Utilities

Import 3

I = ¥ ASCIl Poirts

Exit 5UMS Foints
SDMS Alignmenits
LandXML 1.2 Geometry
Alignments and Profiles

2. Inthe “Export GPK Points to ASCII Coordinate File Dialog Box, select the output file and name it
something meaningful.
Example File Name: kaXXXXXX_a_ali.txt or kaXXXXXX_ali_coords.txt
Delete everything in the Prefix column and set Text to None on everything except Point#, North(Y), and
East(X)
This will only export these fields.
Select the points for this file (IE all alignment points) and click Apply.
a. A message will pop up indicating the file is complete. This will take a minute or so.
b. Review the .txt file that was generated

Hw

oo

¥REPEAT STEPS 2-6 for the Section and EXRW points, making sure to update the file name in step 2
» You can click in the “Output File” field and change the name to the next file, select the next set of
points, and click apply, and it will generate the new text file.

EE-::'E?-T:'::':J.I Coordinate File — e
Oulpu_t Format Output File Fle Credte ™ | h Coordinate Geometry Job: 884 Operator: F
Bl \Downloads\Bentley SR GPK Import\KA-6514-01 RW Legacy'alignment: | @, it Element View Tools

_P'E A /‘K & {‘

Preferences »
Replace "Mo Blevation™ With : | 0.0000

Input File Utility

Replace "Mo Feature” With : | DEFAULT Inpt File Restors

Database Lhilities

Import
a []  Use Duplicate Fiter Tolerance : | 0.000010 | Export » ASCII Points I
Select Points to Export - = | SDMS Points

SDMS Alignments
LandXML 1.2 Geometry
Alignments and Profiles

372293.0920
372267 0150

6410669.3450
6418769.3070

62+00.00 0.
143+00.00_0.0000

CL POINT
CL POINT

499 72352 4800 64708595412 No Hev 63+90.00 50 RW-EX

502 372346.0090 6412869.5308  No Hev 84+00.00 -60. -EX

503 372356.0090 6412865.5630  No Hev 84+00.00 -70.0 -EX

507 3723970688 6417195.7176  No Hev 127+30.00 -125.0 -EX

508 372332 0691 6417199.5083  No Elev 127+30.00 60.0000 RW-EX v
Include Header Apply o o9 B ¥

Information

j alignmentcoords.txt - Notepad

o TheFollowing Text File is Complete : . . .
1) Ci\Users\Laura.R.Baker\Downloads\Bentley SR GPK FIIE_ Edit Format View Help

Import\KA-6314-01 RW Legacyhalignmentcoords et Pc'l”t# North(Y) East(X) Feature

1,372293.8920,6418669.3498,CL POINT,

o 2,372267.0150,6418769.3678,CL POTNT,
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IMPORTING COGO/XML DATA FROM FILE INTO OPENX |Preparing COGO File for Import to OpenX Product |

Alternative Creation of ASCII File for Import

KDOT understands that although we have projects in legacy v8i products, not every entity has access to the
software. With that in mind, guidance is being provided on creation of ASCII files from the legacy v8i data
provided by KDOT ROW Engineering staff without needing Power GEOPAK. Be aware this process could be
cumbersome on longer projects.

1. Locate and open the b_ali_XXX.IRW (input) file in the project files using the notepad application of
your choice.

2. Remove everything in the document except the lines listing the points and northing/easting coordinate
values (as shown below, the highlighted information was removed.

3. Click File>Save As and name the document something meaningful as with the process outlined in the
previous section.

4. This will need to be done for each “IRW" file. File names begin with an alpha starting with “a” and ends
with the type of point expected.

a. Example: a_sec (Section Corner Points), b_ali (Alignment Points, c_xrw (Existing ROW Points),
d_pl (Property Line points, e_prw (Proposed ROW points) with additional alpha characters used
for supplemental changes such as f_xrw for additional existing ROW points).

b. Where COGO in GEOPAK combines all these and lists all points in the file, care will need to be
taken to ensure points from all applicable files are imported.

c. There could be more than one IRW file for each type of point as noted in the examples above.

i b_alig43.irw X Untitled . + B
efore
File Edit  View
and After
Copyright: (c) 2013 Bentley Systems, Incorporated. All rights reserved
Project:

Subject: [ MOMNE ]
Job No. 843 Operator: RW B b_alig43.irw Untitled °
Date: Tuesday MNovember 14, 2823 7:12 am

File Edit View
| SYSTEM FIX 4 ASEC 2 BEAR PRI @ RED NE STA 2 FILE: 'B_ALI"

1 388778.79933416 6448724.3317226
|2 388777.98409291 6441324.3311688
Y 3 308777.16898280 6441924,3271418

$ PROJ KA-5733-81 - CA3843
$ ALIGNMENT INPUT

DES CHA CL
END

L I I .
(Ve T+ I B W I N W
Y
[=]
==
m
S
=
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IMPORTING COGO/XML DATA FROM FILE INTO OPENX | Creating Design File for Proposed Right of Way |

Creating Design File for Proposed Right of Way

Importing Alignment from Survey XML

NOTE: Typically, in OpenRoads, it is recommended to reference data when possible. Right of Way uses a
different stationing interval than Survey/Road, which necessitates importing of the alignment XML following
the guidance below.

1. Start with a new DGN using the ROW 2D Seed file and set Coordinate System (as applicable)
a. File name should use KDOT Bureau of Right of Way naming convention.
b. The Right of Way seed file annotation scale is set to a default value of 1" =500
c. Scale can be adjusted as needed but typically is set to 1" =250’ or 1" =500’

2. Navigate to the Survey Workflow—->Geometry Tab->General Tools Section and select the dropdown
next to Import/Export and select Import Geometry

<l suney J@- »2HERB «-» 2 -

Home Field Book Analyze Edit Terrain Geometry Drawing Productioi

q & Import/Export ) . L T off
6 ~ . Import Geometry = Rev

- Element Point - _
@ Selection i . Impert Horizontal Geometry From Ascii File == Spir
Primary Selection = Import Horizontal Points From Ascii File k
= — , . 7 EY P o

@Q |N0 Feature Defintion .7 Import Vertical Geornetry From Ascii File v od / ; i
Explorer & Export Geometry ~ 0

3. Next you will select the file you would like to import.
a. Navigate to the Survey Folder of the Project and select the SALO1.xml file.

ﬂ Select Files To Import - C\Users\Laura.R.Baker\Downloads\Survey Settings Test',
Loal: in: Survey Settings Test e @- ? o ET
i Mame Date modified
_ | | ka5733stn-01.xml 10/14/2021 %:59 AM
Quickaccess = kag51401_a_alitxt 5/23/2023 8:05 AM
- =| KAB514071_b_sec.txt 5/22/202312:07 PM
=| KAB51401_c_erw.bxt 5/22/2023 12:07 PM
Desktop I D KAE314015al07.xml 4/5/2022 &:45 AM
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IMPORTING COGO/XML DATA FROM FILE INTO OPENX | Creating Design File for Proposed Right of Way |

Import Geometry Dialog - OpenX 10.10+ Products

4. On the Import Geometry dialog box
a. Expand the LandXML tree and select the CL (all the boxes above in the tree will auto-check)
b. Check the box next to “Assign Feature Definition” and in the Linear Features drop down, select
CL-RW.

c. CL-RW has its own annotation group for alignment stationing (see Annotating the Features)
d. Be sure Create Civil Rules is Checked
e. Click Import

Once done you will see “Import Complete”, and the dialog can be closed, and the alignment will be in the file.

o Import Geometry
--HK:'-.Draﬂing'-.-’-'-.ctive Dwo KDOTRC

EIH Alignment
= NoFeature

[] Assign Feature Definitions from Table

Feature Definiticns Table: Survey ROW Feature Table Import xlsx

B 2ssign Feature Definition

o Linear Features: | V |
Point Features: |PL_Right of Way Line Existing v |

B Create Civil Rules
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IMPORTING COGO/XML DATA FROM FILE INTO OPENX | Creating Design File for Proposed Right of Way |

Import Point ASCII Files into OpenX Products

Video Demo

Importing Alignment Points

Each set of points must be imported separately.

1. Continuing in the file created in
the previous step. -:' Survey Ja- h2HER«- + f -
. Home Field Book Analyze Edit Terrain Drawing Productio
2. Navigate to the Survey
Workflow->Geometry < * R s e S B O ¢ = X
. e P it = Rev
Tab->General Tools Section and 87 | ement it Seomctiy s Arcs Point
select the drOdeWﬂ next to @J SE|ECt'°”lL--‘; " & Import Horizontal Geometry From Ascii File = T = Spir
Import/EXport and select Import p”rmaf}‘ Selection I |« Import Herizental Points From Ascii File {"
Horizontal Points from Ascii File @ No Feature Defion "7 mport Vertcal Geometry From Ascil File i A
Explarer ) 1
3. You will get a prompt for selecting

Locate horizontzl element for station
offset method - Reset if station offset
method is not needed.

an alignment for station offset, for Alignment points,
right click to reset past this prompt. NOTE: It may be
necessary to select the alignment for other point types
to see the relationship via the Station-Offset Reports for
Points

4. Next you will select the file you would like to import.

= yiew | Uetault
£ Select Files To Import - C:i\Users\Laura.R.Baker\Downloads\Survey Settings Test\

Laok in: [ | | Survey Seftings Test Jed > mE-
* Name - Date modified
5] KA651207_a_alibet o 5/22/2023 1:38 PM
Quickaccess  “ETKABS1A01_b_secixt 5/22/2023 12:07 PM
Z 5] kA651401_c_enwixt 5/22/2023 12:07 PM

Desktop

5. On the Import Horizontal Points from ASCII File dialog box

a. Click on the ellipses next to Wizard Settings File and navigate to
\WorkSpaces\KDOT\Standards\_Civil\Survey\ROW_Import_Settings.xml
b. Select the Feature Definition PL_Alignment Point
c. Click Import
d. Once done you will see “Import Complete”, and the dialog can be closed.
£ Import Horizontal Points from ASCII File — O X £+ Standards ~ | El lst @ Spatial
i (& Bridge Mame
| Em [ X [l P Q = ‘f'ﬂsmwmgﬂ j%kdutsuweysampladata.csv
Text Import Wizard -~ [ cell A EEOW-BS:\’;:;@" — |
\Wizard Settings File | von_import_settings.xmi | # : SAEE'Z'::S L &
Feature Definition ~ {2 Reports
Feature Definition L seed

Name:

O

| Import Complete

[PL_Alignment Pairt |

[AigrmentPoint |
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IMPORTING COGO/XML DATA FROM FILE INTO OPENX | Creating Design File for Proposed Right of Way |

Importing Section Corner Points

e Repeat Steps 2-5 on the previous page, selecting the ASCII file for Section Corner Points and using
Feature Definition “PL_Section Line.”

= view | Default

~ . o % B -

| £ Import Horizontal Points from ASCII File

CEOBRX @

File Options
i Wizard Settings File

Feature Definition

Feature Definition

E’J Select Files To Import - ChUsers\Laura.R.Baker\Downloads\Survey Settings Test\,

Name

Look in: | Survey Settings Test

V] @2 e @

-

% Mame
KAB51401 5 alitxt -
Quick access [ jmﬁﬂdm_b_sec.mt I
. =| KABS1401_c_erw.bxt

Desktop

Date modified
5/22/2023 1:39 PM
5/22/2023 12:07 PM
5/22/2023 12:07 PM

C\Users\bakeradm\Downloads\Bentley SR - (nt Import to ORDVASCII Expo
I

Text Import Wizard

y PN B VY.
= [m] X

5| & G @

~

. \ow_import_settings 1

~

No Feature Definition

Poirt

B Right of Way

-@ PL_Access Cortrol

@ PL_Ascess Cortrol Existing
@ PL_Alignmert Poirt

& PL City Limits Line

@ PL_Easement Lines -Pemn
@ PL_Easement Lines -Pem Existing
@ PL_Let Linc

-@ PL_Property Line

-@ PL_Right of Way Line

L4

- g
E -@ PL_Section Line I

Importing Existing ROW Points

e Repeat Steps 2-5 on the previous page, selecting the ASCII file for Existing Right of Way Points and
using Feature Definition “PL_Right of Way Line Existing.”

NOTE: You will get a prompt for selecting an alignment for station offset. This can be done if needed for
Station-Offset report, otherwise, right click to reset past this prompt.

= yiew |, Uetault
E’J Select Files To Import - ChUsers\Laura.R,

Look in Survey Settings Test

~

* Name
_ = KABS1401_a_ali bt
Quick access 2] kAg51401_b_sec.ixt

m = KABS1A01 ¢ erw.bit o

Desktop

- - - -

| :1 Impart Horizontal Points fram ASCII File
|

Text Import Wizard
- g e
1 Viizard Setings File
Feature Definition
Feature Definition
rvey Settings Testh, 1 Mame =, 5
Date modified

5/22/2023 1:38 PM
5/22/2023 12:07 PM
5/22/2023 12:07 PM

For instructions on annotating the point names see Annotating the Features
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IMPORTING COGO/XML DATA FROM FILE INTO OPENX | Annotating the Features |

Annotating the Features

Video Demo

Displaying Point Names & Alignment Stationing

NOTE: Annotations may not be displayed as expected if the processes outlined in the previous sections are
not followed.

1. Navigate to the OpenRoads Modeling or Survey Workflow->Drawing Production Tab->Element
Annotation and select Annotate Element

£d Survey |id- oF =
m Home Field Book AnaGeometry I Drawing Prcclu-_'ticnl View Help
ey Gy
R T e AR A P
@1 Shenion T voume B vEew | TC RES P3S | [Amnoiiion=| model Ammotsion + | sec
Primary Selection Clip 4 | Tables Motes f&\ Annnt;:r:EIr:mr:nt
/' * V(’ J ; gb;'l-i) @cf 4'/ "‘I"' (.&\ a2 4 Remove Element Annotations

2. Inthe Annotate Element dialog box, check the box for “All Elements in Model” and you will see a
prompt to “Data Point to annotate all elements in model”
a. Alternatively, you can hit CTRL+A to select all elements in the model.

EI@ Annotate Element

All Elements in Model
Include References [

Data Point to annotate all elements in |
model.

3. Review design file to ensure point numbers and alignment stationing have been annotated as
expected.

521 24
+ -

520 868 523
"85 . 90
|
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IMPORTING COGO/XML DATA FROM FILE INTO OPENX | Appendix |

Appendix

Station-Offset Reports for Points

When the alignment is used during the point import process, you will be able to generate a report showing the
point locations in relationship to the alignment.

Navigate to the Survey Workflow—->Geometry Tab->General Tools->Reports
Click the down arrow and select “Point Feature Station Offset Elevation Report”

The prompts will ask you to locate the alignment and left click to confirm the points.

1 Survey " HE [k« - L =
Home Field Book Analyze Edit Terrain Drawing Production Drawing Sta‘tion Offset E‘evaﬂon Featu re Repor‘t
) Z Import/Export * whe 3] » 77 Offsets and Tapers
(.J‘ k e % [;]::ﬂ EIX::entr ; Tl :}&; . O Y“' = Per:rr;;:r":rpe: Report Createq Wednesday, May 24, 2023
= Element -, e i Civil  Reports| Llines Arcs Point _ Time: 7:35:11 AM
@i Selection i1 * | % Standards * Toggles = - v v v 2 Spirals ¥

Project: Alignment
Primary Selection General Tools % Horizontal Geometry Report

Description:

¥ Horizontal Point Report Baseline (Active) Alignment: CL

L Profile Repart File Name: c’\pwworking\pwlaura\d(267040\Test Import ASCIl.dgn
17 Legal Report Last Revised: 5/24/2023 07:25:07

" Map Check Report Input Grid Factor: Note: All units in this repe
£ Station Offsct Report Point  Description Station Offset Flevation Feature

7 Point Feature Station Offset Elevation REPUHI 499 63+50.00 -60.00 PointiRight of Way\PL_Right of We
77 Station Base Report 559 63+50.00 60.00 Point\Right of Way\PL_Right of Wz

8 Superelevation Report

Contact Information

If you have any questions, issues, or changes, please submit a ticket to KDOT CADD Support via email @
ebitsm@ks.gov and cc KDOT CADD Support at kdot.cadd.support@ks.gov

*Important*

This guidance does not cover all possible scenarios. Coordination with the KDOT Right of Way Engineering staff may be
necessary to ensure deliverables meet their expectations. Care should be exercised to use the KDOT approved version of
any Bentley Platform products in accordance with KDOT’s Design Software Use Policy to avoid issues with schema and
product alignment. As noted in the Overview, use of GeoPak/COGO is not required.

See KDOT CADD Support Design Software (ksdot.gov) for the latest information.
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